
1 

 

VxWorks Temperature Sensor 

Appendix 

 

Devin Raposo 

  

Final Report 

April 19, 2019 

  

CEN 4935 Senior Software Engineering Project 

Instructors: Dr. Janusz Zalewski and Dr. Fernando 

Gonzalez 

Department of Software Engineering  

Florida Gulf Coast University 

Ft. Myers, FL 33965 

  

 

  

  

   

Copyright © 2019 by Florida Gulf Coast University 

 

 



2 

 

A0. Introduction 

 

The purpose of this project is to extend a previous semester‟s project involving the development 

of a USB [1] driver [2] for the real-time operating system [3] VxWorks [4] running on the Wind 

River PowerQUICC II Pro SBC8349 [5] which interfaces with PCsensor‟s [6] TEMPer Caps 

Lock to Excel [7] USB temperature sensor to read from and display to an HTML [8] page the 

current temperature in the laboratory in room 429 at FGCU‟s [9] Holmes Hall [10] building. This 

webpage must be accessible in a web browser from anywhere in the world via an Internet 

connection and must also be hosted on the SBC8349 board itself. The USB driver executable is 

accessible from a separate USB flash drive, and both the TEMPer USB sensor and the separate 

flash drive are attached to the same USB hub which is attached to the SBC8349 board. Another 

purpose of this project by way of this documentation is to explain a streamlined, detailed and 

unambiguous process by which future developers with no knowledge of developing software for 

VxWorks shall be able to get an example software up and running on the SBC board in room 429 

in Holmes Hall with as little difficulty as possible. In the event that a different kind of board 

running VxWorks were being used as a development environment, the majority of this 

documentation shall be applicable to that environment as well.  

The previous developer whom worked on this project as explained in their documentation [11] 

wrote and implemented the USB driver but was never able to successfully get the driver to 

correctly read from and display the current temperature from the sensor. In addition, the previous 

iteration of the project had no Internet connectivity capabilities implemented at the time of the 

project‟s completion. It was therefore determined that these issues should be addressed so as to 

position the project in a position which can be considered complete. Therefore, the overall design 

of the project as detailed visually in the Physical Diagram (Figure 1) did not change. Figure 2 

shows a “real world” explanation of how the TEMPer sensor which is attached to the SBC8349 

board interfaces with the HTML page hosted over the Internet using photographs of the sensor 

and board in tandem with diagrams. Figure 3 shows a photograph of the USB flash drive and 

USB TEMPer sensor attached to a USB hub which is attached to the SBC8349 board. Figure 4 

shows a detailed photograph of the SBC8349 by itself. 
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Figure 1. Physical Diagram of the System 
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Figure 2. Sensor and Board Connecting to the Internet (Alternate Physical Diagram) 

 

 

Figure 3. USB Hub with TEMPer Sensor and USB Flash Drive 
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Figure 4. Detailed View of the PowerQUICC II Pro SBC8349 board 

 

 

There were only three core requirements determined as relevant to this project, which are 

described in the table below. 

 

 

 

 

 



6 

 

Requirement # Description Pass/Fail Notes 

1 

VxWorks must host an 

HTML file which the user 

accesses over the Internet 

accessible from outside the 

FGCU network. 

PASS 

Was successfully 

executed during 

testing. 

2 

VxWorks must host an XML 

file which the HTML 

accesses when the user 

requests data from it over the 

Internet accessible from 

outside the FGCU network. 

PASS 

Was successfully 

executed during 

testing. 

3 

VxWorks must read data 

from USB TEMPer sensor 

inserted into a USB hub 

attached to the SBC8349. 

FAIL See conclusion 
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A1. Developer’s Instructions 

 

The following section is a thorough and unambiguous process which when properly followed 

shall adequately position the developer in a position which shall allow them to develop any 

software for the VxWorks operating system to be run on the SBC8349 board, including the USB 

TEMPer driver and HTML hosting code contained within Section A5 of this document which 

contains all source code relevant to the project, the entirety of which is also available in the 

„Temperature‟ folder on the USB flash drive attached to the USB hub in room 429 of Holmes 

Hall. The following steps are numbered sequentially according to the order in which they should 

be executed in. A step is referred to according to the instruction set number it‟s from and the step 

number. For example, “step 1.8” would refer to step 8 from the first instruction set (instruction 

sets are delineated by a bold heading). Steps from section A2 (the user‟s instructions) are not 

regarded by this section, and vice versa. Any and all visual diagrams and photographs contained 

within this section are referenced within a corresponding numbered instruction step, and that 

specific instruction step shall also be listed within the corresponding visual‟s label. 

 

The first instruction set details the process of setting up the SBC8349 board running VxWorks 

and starting up the Wind River Workbench [12] development platform on the Windows PC 

attached to the SBC8349 board. These steps must always be followed before proceeding to 

development. Note that if any of the FTP server program, lmtools licensing program, or Wind 

River Workbench programs are not already installed on the Windows computer, development on 

VxWorks cannot be begun and therefore such installations need to be made. These processes are 

beyond the scope of this report. Reference [13] details this process thoroughly. 

 

1. Opening Wind River Workbench and Preparing the SBC8349 board 

1. If the PC running Windows XP which contains an installation of Wind River Workbench and 

the required licensing to run it is not already powered on, power on the PC. Turn on the monitor 

attached to it and make sure a keyboard and mouse are also connected. 

2. Log into a Windows XP user account with administrator rights so as to be able to interface 

with the device. If unable to determine the login credentials for any of the previously established 
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user accounts, make a new one by following the onscreen prompts, ensuring that the new 

account has administrator credentials attached to it. 

3. If the SBC8349 has already previously been connected and ready to use, make sure that it is 

powered off, meaning that the power switch on the rear side of the device is sticking all the way 

out and can be pushed inward to power the device on given that the device has a power source 

and then proceed to step 4. If it is not already connected, perform the following steps to ensure 

that the device is connected and ready to use: attach a three-pronged AC power cable to the 

indentation on the rightward side of the device and attach the other side to an available power 

outlet in the room. Flip the switch next to the A/C indentation from “O” to “I”. Light sources 

visible in the center and rear side of the device should turn on to indicate that the device is 

receiving power. Attach one side of an Ethernet cord to port A on the rear side of the device and 

the other side of the cord to jack 19 (the bottom-left jack on the outlet which contains jack 17 – 

20) available within the lab, which is needed specifically so as to host files on the IP address 

69.88.163.17 on port 80. A light on the rear side of the SBC8349‟s Ethernet port should power 

on to indicate that there is suitable Ethernet connectivity available. Attach one side of a serial 

cable to the COM1 serial port on the rear side of the device, and attach the other side to the 

COM1 serial port located on the rear side of the Windows PC. Attach the USB A female to mini 

USB cable to the port on the rear side of the SBC8349 located to the left of the Ethernet port. 

Attach the male USB to mini USB cable from the female USB port to the USB hub. Attach the 

USB hub‟s power source to an open power outlet on the wall in the lab. A blue light should 

power on along the periphery of the hub device to indicate that the hub is powered on and ready 

to go.  

4. On the home desktop screen of the Windows PC, if a shortcut to the FTP Server application is 

displayed, use it to run the FTP Server program. If there isn‟t one available, run a search of all 

programs using the start menu located on the bottom-left corner of the screen to find the FTP 

Server Application and create a shortcut for later usage. 

5. In the „Users‟ tab on the topward side of the FTP Server program, ensure that the „target‟ user 

is chosen as the currently active one and that its associated password is „1234‟. If the user 

„target‟ is not currently active, choose it from the „User Name‟ dropdown and set the password to 

„1234‟. These are the credentials which shall later on during this process be set. Ensure that the 

current home directory is set to “C:\TEMP”. This is the directory where VxWorks shall attempt 
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to load a VxWorks image file from. Figure 5 displays a screenshot of the FTP server and the 

User / Rights Security Dialog window open. 

 

Figure 5. FTP Server Client and User Dialog Window (Step 1.5) 

 

6. On the home desktop screen of the Windows PC, if a shortcut to the lmtools application is 

displayed, use it to run the lmtools program. If there isn‟t one available, run a search of all 

programs using the start menu located on the bottom-left corner of the screen to find the lmtools 

application and create a shortcut for later usage. 

7. In the lmtools application under the Server/License file tab, make sure „Configuration using 

Services‟ is selected and „Wind River FLEXlm Service‟ is selected in the list form. Figure 6 

displays a screenshot of the Service/License file tab of the lmtools application. 
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Figure 6. Service/License File tab for lmtools (Step 1.7) 

 

8. Switch to the „Start/Stop/Reread‟ tab. Make sure „Wind River FLEXlm Service‟ is selected in 

the choice field. If the program has not already been set to read the licensing file from that 

directory, switch to the Config Services tab. The licensing file „WRSLicense.lic‟ is located at 

„C:\WindRiver\licadmintools-1.3‟. The „lmgrd.exe‟ executable is located at 

„C:\WindRiver\licadmintools-1.3\x86-wind32‟. The path to the debug log file „Debug‟ is located 

at „C:\WindRiver\licadmintools-1.3\x86-win32‟. Click „Start Server‟ located in the 

„Start/Stop/Reread‟ tab to start the licensing server. Figure 7 illustrates how the lmtools program 

appears when in the „Start/Stop/Reread‟ tab. 
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Figure 7. Start/Stop/Reread Tab in lmtools (Step 1.8) 

 

9. Leave both the lmtools and FTP server programs running before starting Wind River 

Workbench. On the Windows PC desktop, if there isn‟t a shortcut to Wind River Workbench 

available, perform a search of the PC to find the executable and create a shortcut for later usage. 

10. Wait until Workbench has fully loaded and objects within the program can be interfaced with 

using the mouse. Assuming the lmtools server is running, Workbench should start without any 

error messages. If an error message window does appear, close the program, restart the server, 

make sure the board is powered off, and try again. If issues continue to arise, it‟s best to restart 

the computer and start again from step 1.4 until no error messages appear upon running 

Workbench. 

 

The next set of steps details how to create a downloadable kernel module project to be ran on the 

SBC8349 as well as how to execute the created project on the board. This is one of two ways to 

run code on the SBC8349, the second of which is detailed following this instruction set and is the 

third instruction set overall. This method is quicker than the latter method and thus is better for 
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quick development and testing. Code written using the former method can be reused by the latter 

method which is more applicable for real-world deployment. 

 

2. Create and Execute a Downloadable Kernel Module Project 

1. In the topmost panel of Wind River Workbench, click File -> New -> VxWorks 

Downloadable Kernel Module Project. Figure 8 shows a screenshot of the Workbench 

environment displaying where these clickables are located. 

 

 

Figure 8. Creating a Downloadable Kernel Module Project (Step 2.1) 

 



13 

 

2. In the next window that appears, enter a project name in the input field and then click “Next” 

and then “Next” again. Figure 9 displays a view of the downloadable kernel module project 

naming window. 

 

Figure 9. Downloadable Kernel Module Project Naming Window (Step 2.2) 

 

3. In the next window that appears, uncheck any and all boxes in the list of build specs whose 

names start with “SIMNT”. In the dropdown below, change the active build spec to 

“PPC32gnu”. Click “Next”, “Next” again, and then “Finish” to create a new project. 

4. In the Project Explorer view at the top-left corner of the screen, right-click the project‟s name 

and click New -> File. 

5. In the window that appears next, click the parent folder in the choice field. In the input field 

beneath it, type “yourFileNameHere.c” and then click “Finish” to create a new C file. VxWorks 

applications are written in the C programming language. [14] It is recommended to already be 

familiar with writing programs in this language before proceeding any further. 
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6. The C file will open in the document editor view so that the developer can edit it and write 

code. Write a program in the C file so that it can be successfully compiled. It‟s not required that 

a developer have a function named “main()”, as the developer picks what is defined as the entry 

point/main function later. To include additional C source files into a project, it‟s simplest to drag 

and drop the C source files from Windows Explorer into the Project Explorer view so that they 

are added into the same directory as the C file created during Step 5 of this instruction set. 

Associated header files must be included at 

“C:\WindRiver\vxworks6.9\yourProjectNameHere\target\h”. 

7. Once the source file has been written, right-click the project name as it appears in the Project 

Explorer window and click either “Build Project” or “Rebuild Project”. If the source file 

compiles and any and all header files included are inserted into the directory as listed in step 6 of 

this instruction set, the project shall build without throwing any errors to the Build Console 

window on the bottommost section of Workbench and the developer may proceed to step 8 of 

this instruction set. If any errors are thrown and the build process is not successful, ensure that all 

header files are correctly placed and that there are no issues with the newly created source file. If 

during the build process a window appears asking the developer to generate required includes, 

click “Generate Includes”, then “Next” on the next window, “Next” on the next window, 

uncheck all search paths in the input field which begin with “SIMNT”, and then click “Finish” to 

begin the build process. Do not proceed to step 8 of this instruction set until the build process is 

successfully completed. 

8. In the Terminal window located at the bottommost section of Workbench, click the “Connect” 

button, which appears graphically as two green boxes connected to each other by several 

perpendicular line segments. If this button is not clickable, then no terminal connection has been 

previously defined within Workbench and the developer will have to define a new one. Click the 

“New Terminal Connection in Current View” button and then click “OK” in the next window 

without changing any values to create a new terminal connection. If Workbench does not 

automatically connect via the new connection, click the “Connect” button. 

9. Ensure that the SBC8349 PowerQUICC II Pro is fully prepared for usage as instructed in 

instruction set 1. If these steps have not yet been taken, do not proceed with this instruction set; 

instead, follow the instructions from step 1.3 from instruction set 1. Next, make sure that the 

Terminal window is active and visible to the developer. If the Terminal window cannot be found 
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anywhere within the Workbench development environment, click Window -> Reset Perspective 

at the top of Workbench to bring all views to their default position and make the Terminal 

window visible to the developer again. Power on the SBC8349 device by pressing in the 

“POWER” switch located on the rear side of the board. In the Terminal window, text output 

should appear which is being sent from the SBC8349 running VxWorks to the Windows PC 

running Workbench. VxWorks shall automatically attempt to boot using an image file located at 

the directory it is set to attempt to read from (by default this directory is C:\TEMP with the file 

being named „vxWorks‟ with no file extension) after a few seconds as long as the developer does 

not input any keystrokes into the terminal. If the developer does insert a keystroke, auto-booting 

shall be halted. Type “@” and press enter/return to begin the boot process if this happens. To 

print the currently saved boot parameters, type “p” and press enter/return and the boot 

parameters shall be listed within the terminal. To change these boot parameters, type “c” and 

press enter/return and enter new argument values for the boot parameters (press enter/return to 

leave a boot parameter unchanged or type “.” to clear a parameter). By default these parameters 

should not need to be changed, as the IP information, username (“target” as chosen in step 1.5 of 

the first instruction set), password (“1234” as chosen in step 1.5 of the first instruction set), 

hostname (“JZ-HP-WINXP”), filename location (“C:\TEMP”), target name (“SBC8349”), boot 

device (“mottsec0”) and processor number (“0”) should all be previously chosen. To change 

where VxWorks should attempt to load an image file from, change the “file name” parameter to 

the directory where the image file is located with the image file‟s name included (make sure that 

an associated .sym file is included in that directory). If VxWorks does not boot properly or 

hangs, do not proceed to step 2.10. Instead, ensure all boot parameters are correct and that there 

is an image file able to be loaded from at the boot file parameter given to VxWorks. Reset the 

power switch to begin the boot process anew if need be. Figure 10 displays a view of the 

Terminal window after the developer has successfully connected to and booted up VxWorks 

running the SBC8349. 
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Figure 10. Terminal Connection and VxWorks Booting (Step 2.9) 

 

10. To deploy code on VxWorks from Workbench, a target server connection (different from the 

terminal connection) must be established if this has not already been done previously. In the 

Remote Systems window visible at the bottomleft corner of the Workbench environment, look 

for a listing which reads “VxWorks_69.88.163.17 (Wind River VxWorks 6.9)”. If this is visible, 

proceed to step 2.11. If it is not visible, click the “Define a connection to remote system” button 

(appearing visually as a box with three lines jutting outward from it with a plus sign next to it). 

Click “Wind River VxWorks 6.x Target Server Connection”, then click “Next”, list the target 

name/IP address (best to choose “69.88.163.17”), and then click “Finish”. 

11. If not connected automatically to this target server connection (meaning that the “Connect” 

button is grayed out and the connection listing populated with information is already connected), 

click the “Connect” button (appearing visually as two boxes connected to each other by 

perpendicular line segments).  

12. Right-click the new connection‟s name in the Remote Systems view and click “VxWorks 

Kernel Task”. 
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13. In the Launch Context window, click the newly created connection. In the Entry Point field, 

click “Browse”, click the plus sign next to “yourProjectName.out”, and then choose whichever 

function the developer defines as the entry point (for example, a main function). Click “OK”. 

14. Click “Run”. The program shall run, and any and all output shall be printed (such as 

printf() [22] statements) to the terminal. If a window appears stating that there are unresolved 

external symbols, usually this means that a source file was not properly included in the project 

and that only the declaration of a function used could be found in the header file. If this appears, 

make sure that any and all required source files are included in the project. 

 

The following instruction set details the steps by which to create a real time process project. 

Builds generated in a real time process project are .vxe executables which can be ran on 

VxWorks via the terminal. These executables can be ran from the USB flash drive inserted into 

the USB hub drive attached to the SBC8349. 

 

3. Creating and running a Real Time Process Project 

1. Perform the first four steps from the second instruction set titled “Create and Execute a 

Downloadable Kernel Module Project”. If these steps have not already been executed, do not 

continue onto step 3.2. 

2. Click File -> New -> VxWorks Real Time Process Project. 

3. Give the project a name, click “Next” three times, uncheck all build specs which begin with 

“SIMPENTIUM”, and set the active build spec to “PPC32gnu_RTP”. Click “Finish”. 

4. Perform steps 2.4 to 2.8 for the newly-created Real Time Process project to create a new C 

file, populate it with compilable code, include all header and other source files as needed, create 

a terminal connection if one does not already exist, connect to the terminal connection, and build 

the project. 

5. When built, a real time process project exports a .vxe executable. This executable by default 

shall appear in the directory 

“C:\WindRiver\workspace\yourProjectNameHere\PPC32gnu_RTP\yourProjectNameHere\Debu

g”. Go to that directory using Windows Explorer, take the newly-created .vxe executable and 

insert it anywhere on a USB flash drive which is attached to the Windows PC. Remove the USB 

flash drive from the Windows PC and insert it into the USB hub attached to the SBC8349. 
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6. If VxWorks hasn‟t been started yet and the developer cannot input commands into the 

terminal shell, perform steps 2.8 and 2.9. Do not proceed to step 3.7 if these steps have not been 

performed yet. 

7. Once VxWorks has booted up, enter the command “devs” to list all the devices attached to the 

SBC8349. The default image boot file shall display the USB flash drive inserted into the USB 

hub as “\bd0”. If it does not appear, the wrong image file has been loaded up. This image file and 

its associated .sym file are backed up at “C:\TEMP\VxWorksTempImage”. Take both 

“vxWorks” (no file extension) and “vxWorks.sym” and place them at “C:\TEMP” if you are 

having trouble and then reboot using the new image file. Rename the image files that were 

already placed at “C:\TEMP” so that they are not overwritten. Make sure to always have backups 

of the “C:\TEMP\VxWorksTempImage” image file available on the Windows PC or on a flash 

drive, as correctly configuring an image file to do these things can be a complex and unintuitive 

process to perform. As of the time of this writing, the correct image file is placed at the 

“C:\TEMP” directory and so no image file configuration work should be necessary. 

8. Enter the command “cmd” to change the terminal type to the VxWorks command line 

interpreter. The “->” (arrow) which appears at the start of any line in the terminal shell should 

change to a “#” (pound sign). This is necessary as the “rtp” command cannot be executed using 

the C interpreter the VxWorks shell uses by default. 

9. Type “rtp exec /bd0/yourProjectNameHere.vxe” and press enter/return to run the VxWorks 

executable which sits on the USB flash drive on the SBC8349 using the VxWorks operating 

system. Any and all outputs such as “printf()” statements shall print in the terminal. 

 

It‟s important to note that as of this writing the image file configures the USB TEMPer device to 

appear as “\usbMse” in the shell, which is okay as it still is accessed in the same way. 

 

The following instruction set details the steps a developer must take to host the HTML file on the 

SBC8349 running VxWorks so that it can be connected to over the Internet. It also states the 

steps the developer must take to host the XML [15] file which is where the data from the 

TEMPer sensor is sent and what is read from when the HTML file requests data. These two 

programs can be consolidated into one if the developer prefers, but for the sake of simplicity for 

this documentation are split into two separate projects. Both of these programs use vxUtils [16], 
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an open-source library by Arthur Benilov for hosting web content on VxWorks. Example code 

[17] is available on the vxUtils site which explains its functionality in detail. The following 

instruction set assumes that at least the first two instruction sets have been followed and that the 

developer has developed a working knowledge of how to execute the steps contained within 

those first two instruction sets. The following instruction set shall instruct the developer to 

execute code using the Downloadable Kernel Module method of running code on VxWorks, but 

the Real Time Process executable method can be followed instead if the developer prefers to 

execute the code using a USB flash drive. All source code necessary is available on the USB 

flash drive in the “Temperature” folder already attached to the USB hub at the time of this 

writing. 

 

4. Hosting separate HTML and XML pages on VxWorks 

1. If the HTML Downloadable Kernel Module project has not already been created in 

Workbench, create one. Give it a main source file and include the code contained in the 

“httpandxmlTEMPer.c” file located in the Temperature folder in the USB flash drive, also 

included in section A5 of this documentation (the Appendix). Make sure that “httpd.c” (the 

source from the vxUtils library needed to compile and run this project) is included with the 

project, and make sure that “httpd.h” is included in the folder 

“C:\WindRiver\vxworks6.9\yourProjectNameHere\target\h.” 

2. By default, this project will attempt to use printf() to create an HTML file and host it over 

VxWorks. If the developer prefers, the program could later be edited to read this data from a text 

file either on the host computer or located on a USB flash drive. It will use sprintf() [23] 

for printing to the XML file. 

3. Build the project and run it as a VxWorks Kernel Task as outlined in instruction set 2. This 

shall host the HTML file on VxWorks over the Internet at the IP address: 

http://69.88.163.17/temperature.html (this is on port 80). It will host the XML file at the IP 

address: http://69.88.163.17/temperaturedata.xml (also on port 80). 

4. Test that execution of the project was successful by visiting the IP addresses where both the 

HTML and XML files are hosted. Figures 11 and 12 display images of how the HTML and XML 

files are formatted upon their initial accesses in a web browser, respectively. 
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Figure 11. HTML page displaying data from XML page from outside FGCU network (Step 4.6) 

 

 

Figure 12. XML page displaying data on its own (Step 4.6) 

 

In the event that a future developer should feel the need to edit the formatting and appearance of 

the website, simply change the contents of the HTML file. Successfully doing so shall require 

working knowledge of HTML, CSS [19], and JavaScript [20] (particularly the “callback()” 

[21] function). The pipeline developed to host the HTML and XML files could also be used by a 

developer to host an external CSS file if the developer preferred. Ensure that a rigid 

understanding of these languages exists before executing the HTML hosting code from vxUtils 

onto the SBC8349 board. Anytime the developer wants to update the HTML or JavaScript code, 

it‟s best to rebuild the project, reboot the SBC8349, and then run the newly built project again on 

the board to update the contents of the website. 
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A2. Operating (User) Instructions 

 

The following instruction set when followed shall allow the user to view the data reading from 

the USB TEMPer sensor attached to the SBC8349 running VxWorks from any web browser in 

the world over the Internet. The instruction set assumes that a developer has already followed 

instruction set 4 from section A1 of this documentation, and therefore an HTML and XML file 

are already hosted at the IP address dedicated to hosting them. If those steps have not been 

performed, the user won‟t be able to access any data hosted on the SBC8349. 

 

1. Open a web browser.  

2. In the URL address bar, type the following address: “http://69.88.163.17/temperature.html” 

3. To request the temperature reading from the lab in room 429 of Holmes Hall at FGCU, click 

the “Request temperature data” button with a mouse (or tap the screen if accessing from a 

smartphone or tablet device). 

4. The data shall be presented to the user in a format illustrated by Figure 13. If the HTML file 

displays correctly as in Figure 11 but the output does not display as in Figure 13, then the XML 

file has not been hosted and the developer must be consulted to host the XML file. If the web 

browser displays an error message when trying to access the HTML file as in Figure 14, then the 

HTML file has not been hosted and the developer must be consulted to host the HTML file. 

 

 

Figure 13. Formatted Temperature Data in HTML over VxWorks (Step 4) 
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Figure 14. HTML Error Message Example 
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A3. Conclusion 

 

Over the course of the project‟s development, it was determined that a variety of previously 

unforeseen and significant technical issues would need to be overcome before progress on the 

originally assigned project (performing maintenance on the temperature USB driver so that it 

would read properly) could be accomplished. The first of these issues was learning how to 

properly and consistently start up Workbench using the licensing server, which initially proved 

problematic. The next issue was determining how to consistently and without error get VxWorks 

to boot up from an image file; a developer from a previous semester had seemingly moved the 

image file necessary to boot the device into a different directory. There was then a long period of 

difficulty getting VxWorks to acknowledge the USB flash drive (“\bd0”) connected to the USB 

hub; the issue here was determined to be an improperly configured kernel configuration and 

associated boot image file. There was difficulty learning how to properly and without error use 

the vxUtils library; frequent email correspondence with its author, Arthur Benilov, would prove 

fruitful in gathering an understanding of developing with the library.  

Compounding all of these issues was the sheer bulk of information dispersed between the seven 

documents used as initial reference; combined with the lack of suitable information and 

previously asked questions on the Internet in relation to VxWorks, determining the processes 

necessary to consistently and successfully interface with VxWorks as a solo developer would 

take a considerable amount of time and effort, much of which was not fruitful simply due to the 

bounty of information and how much of it was contradicting of each other. The sheer variety and 

severity of issues brought with it the necessity to write a definitive and concise document which 

if followed correctly shall bring future developers up to speed with VxWorks with no issues, 

with much of the housekeeping already performed for them.  

The most problematic of issues would arrive late in the semester, when a necessary reboot during 

testing of the newly-developed HTML hosting functionality caused a complete cease of output to 

the VxWorks terminal in Workbench. Shortly after, the second VxWorks box in the lab 

completely died. It was determined then that a new device capable of running VxWorks would 

be necessary to purchase before the core thrust of this project can truly be tested, that being the 

ability to read from the USB TEMPer sensor. After a new SBC8349 was purchased and installed 

with the host PC, in addition to several changes to the code deemed necessary after further 
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testing could finally commence, the HTML and XML pages were successfully hosted on the 

SBC8349.  

All steps outlined in section A1 of this documentation must be thoroughly followed, or else no 

further work shall be feasible or productive to carry out. The source file “httpandxmlTEMPer.c” 

available in section A5 of this documentation as well as the USB flash drive in the lab is an 

untested suggestion of how to proceed. It contains the HTML hosting code, the XML hosting 

code, and the previous developer‟s USB driver code. Edits to these USB driver functions are 

necessary to achieve a successful temperature read from the USB TEMPer sensor. These other 

functions are included largely without edits and are the effort of the previous developer to work 

on this project, whom was ultimately unsuccessful. [11] The USB TEMPer sensor has been 

tested on a Windows PC using PCsensor‟s proprietary temperature-reading application [7] and 

has been deemed functional as of this writing. It is recommended that future developers focus 

first on understanding VxWorks and Wind River Workbench before proceeding to diagnose the 

current USB TEMPer driver code for any and all issues. 
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A5. Source Code 

 

The following is a more readable version of the HTML file read from by the HTML hosting 

function (“htmlandxmlTEMPer.c” displayed below) which is used and hosted on the SBC8349 

over the Internet. It is titled “temperature.html” and is also located on the flash drive attached to 

the USB hub in the lab in room 429 in Holmes Hall. 

 

<!DOCTYPE html> 

<html lang="en"> 

<head> 

<meta charset="utf-8"> 

<title>VxWorks Temperature Sensor</title> 

<style> 

body { 

 text-align: center; 

} 

data { 

 float: left; 

 width: 200px; 

 height: 100px; 

 margin: 200px; 

 border: 1px solid rgba(0,0,0,.2); 

 background: rgb(0,45,114); 

} 

button { 

  background-color: rgb(0,45,114); 

  border: none; 

  color: white; 

  padding: 15px 32px; 

  text-align: center; 

  text-decoration: none; 

  display: inline-block; 

  font-size: 16px; 

  margin: 4px 2px; 

  cursor: pointer; 

} 

</style> 

</head> 

<body> 

<h1>VxWorks Temperature Sensor</h1> 

<p>Click the button below to read data from the temperature sensor attached 

to VxWorks:</p> 

<button class = "button" onclick = 

"loadData('http://69.88.163.17/temperaturedata.xml',updateData)">Request 

temperature data</button> 

<br> 

<br> 

<div id="data"></div> 

<script> 

 function updateData(xhttp) 

 { 
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 var xmlDoc, text, celsius, fahrenheit; 

 xmlDoc = xhttp.responseXML; 

 var date = new Date(); 

 if(!date)  

 { 

  document.getElementById("data").innerHTML = "Date retrieval 

failed"; 

  console.log("Date retrieval failed"); 

  return; 

 } 

 var months = ["January", "February", "March", "April", "May", "June", 

"July", "August", "September", "October", "November", "December"]; 

 var days = ["Sunday", "Monday", "Tuesday", "Wednesday", "Thursday", 

"Friday", "Saturday"]; 

 text = "The temperature in celsius and fahrenheit in the FGCU Holmes 

Engineering lab, room 429 on "; 

 text += days[date.getDay()] + ", "; 

 text += months[date.getMonth()] + " "; 

 text += date.getDate() + ", "; 

 text += date.getFullYear() + " at "; 

 var currHour = date.getHours(); 

 if(currHour > 12) 

 { 

  currHour -= 12; 

  text += currHour + ":"; 

  var currMinute = date.getMinutes(); 

  if(currMinute < 10) text += "0"; 

  text += currMinute + ":"; 

  var currSecond = date.getSeconds(); 

  if(currSecond < 10) text += "0"; 

  text += currSecond + " PM"; 

 } 

 else 

 { 

  text += currHour + ":"; 

  var currMinute = date.getMinutes(); 

  if(currMinute < 10) text += "0"; 

  text += currMinute + ":"; 

  var currSecond = date.getSeconds(); 

  if(currSecond < 10) text += "0"; 

  text += currSecond + " AM"; 

 } 

 text += " is:<br><br>"; 

 celsius = xmlDoc.getElementsByTagName("CELSIUS"); 

 text += "Celsius: "; 

 text += celsius[0].childNodes[0].nodeValue + " °C<br>"; 

 fahrenheit = xmlDoc.getElementsByTagName("FAHRENHEIT"); 

 text += "Fahrenheit: "; 

 text += fahrenheit[0].childNodes[0].nodeValue + " °F<br>"; 

 document.getElementById("data").innerHTML = text; 

 console.log(text); 

 } 

 function loadData(url, callback) 

 { 

 var xhttp; 

 if(window.XMLHttpRequest) 

 { 
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  //code for modern browsers 

  xhttp = new XMLHttpRequest(); 

  if(!xhttp) 

  { 

   document.getElementById("data").innerHTML = "XMLHttpRequest 

failed."; 

   console.log("XMLHttpRequest failed."); 

   return; 

  } 

 } 

 else 

 { 

  //code for IE6, IE5 

  xhttp = new ActiveXObject("Microsoft.XMLHTTP"); 

  if(!xhttp) 

  { 

   console.log("ActiveXObject creation failed."); 

   return; 

  } 

 } 

 var i = 1; 

 xhttp.onreadystatechange = function()  

 { 

  if(this.readyState == 4) 

  { 

   callback(this); 

  } 

 }; 

 xhttp.open("GET", url, true); 

 xhttp.send(); 

 } 

</script> 

</body> 

</html>  

 

The following is the C source code which is executed by VxWorks to host the HTML and XML 

files over the Internet on the SBC8349. It also contains the USB TEMPer driver code written by 

the previous developer. 

 

#include <vxWorks.h> 

#include <selectLib.h> 

#include <semLib.h> 

#include <logLib.h> 

#include <errno.h> 

#include <errnoLib.h> 

#include <iosLib.h> 

#include <rngLib.h> 

#include <stdio.h> 

#include <httpd.h> 

#include <string.h> 

/* 

#include <drv/usb2/PCSensor/usb2TEMPerLib.h> 
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LOCAL BOOL Global_Init = FALSE; 

void usb2TEMPerSuspendResume(UINT32 Device, void* Data); 

 

LOCAL BOOL usb2TEMPerInitializeDevice(USB2_TEMPER_DEVICE* Device) 

{ 

 if(Device->TransferURB == NULL) 

 { 

  Device->TransferURB = 

(USBHST_URB*)OSS_CALLOC(sizeof(USBHST_URB)); 

  if(Device->TransferURB == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

allocate the transfer URB.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 

  } 

 } 

  

 if(Device->WakeupList == NULL) 

 { 

  Device->WakeupList = 

(SEL_WAKEUP_LIST*)OSS_CALLOC(sizeof(SEL_WAKEUP_LIST)); 

  if(Device->WakeupList == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

allocate the device wakeup list.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 

  } 

  selWakeupListInit(Device->WakeupList); 

  Device->IsWakeupListInitialized = TRUE; 

 } 

  

 Device->DeviceTimeout = 5000; 

 if(Device->ReadMutex == NULL) 

 { 

  Device->ReadMutex = 

semMCreate(SEM_Q_PRIORITY|SEM_DELETE_SAFE|SEM_INVERSION_SAFE); 

  if(Device->ReadMutex == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

create the read mutex.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 

  } 

 } 

 Device->RingBufferCount = 32; 

 if(Device->RingBuffer == NULL) 

 { 

  Device->RingBuffer = rngCreate(Device-

>RingBufferCount*sizeof(USB2_TEMPER_REPORT)); 

  if(Device->RingBuffer == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

create the ring buffer.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 
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  } 

 } 

 if(Device->TransferSemaphore == NULL) 

 { 

  Device->TransferSemaphore = 

semMCreate(SEM_Q_PRIORITY|SEM_DELETE_SAFE|SEM_INVERSION_SAFE); 

  if(Device->TransferSemaphore == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

create the transfer semaphore.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 

  } 

 } 

 if(Device->Report == NULL) 

 { 

  Device->Report = 

(USB2_TEMPER_REPORT*)OSS_CALLOC(sizeof(USB2_TEMPER_REPORT)); 

  if(Device->Report == NULL) 

  { 

   USB_TEMPER_ERR("usb2TEMPerInitializeDevice(): Failed to 

allocate the report.\n", 

    0, 0, 0, 0, 0, 0); 

   return FALSE; 

  } 

 } 

 USB_TEMPER_INFO("usb2TEMPerInitializeDevice(): SUCCEEDED!\n", 0, 0, 0, 

0, 0, 0); 

 return TRUE; 

} 

 

LOCAL void usb2TEMPerUninitializeDevice(USB2_TEMPER_DEVICE* Device) 

{ 

 if(Device != NULL) 

 { 

  if(Device->RingBuffer != NULL) 

  { 

   rngDelete(Device->RingBuffer); 

   Device->RingBuffer = NULL; 

  } 

  if(Device->TransferSemaphore != NULL) 

  { 

   semDelete(Device->TransferSemaphore); 

   Device->TransferSemaphore = NULL; 

  } 

  if(Device->ReadMutex != NULL) 

  { 

   semDelete(Device->ReadMutex); 

   Device->ReadMutex = NULL; 

  } 

  if((Device->WakeupList != NULL) && (Device-

>IsWakeupListInitialized)) 

  { 

   selWakeupListTerm(Device->WakeupList); 

   OSS_FREE(Device->WakeupList); 

   Device->WakeupList = NULL; 

   Device->IsWakeupListInitialized = FALSE; 
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  } 

  if(Device->TransferURB != NULL) 

  { 

   OSS_FREE(Device->TransferURB); 

   Device->TransferURB = NULL; 

  } 

  if(Device->Report != NULL) 

  { 

   OSS_FREE(Device->Report); 

   Device->Report = NULL; 

  } 

  OSS_FREE(Device); 

  Device = NULL; 

 } 

} 

 

LOCAL USB2_TEMPER_DEVICE* usb2TEMPerGetDevice() 

{ 

 static USB2_TEMPER_DEVICE* Result = NULL; 

 if(Result == NULL) 

 { 

  Result = 

(USB2_TEMPER_DEVICE*)OSS_CALLOC(sizeof(USB2_TEMPER_DEVICE)); 

  if(!usb2TEMPerInitializeDevice(Result)) 

  { 

   USB_TEMPER_ERR("usb2TEMPerGetDevice(): Failed to initialize 

the device at all.\n", 

    0, 0, 0, 0, 0, 0); 

   usb2TEMPerUninitializeDevice(Result); 

   OSS_FREE(Result); 

   Result = NULL; 

  } 

 } 

 return Result; 

} 

 

LOCAL USB2_INTERFACE usb2TEMPerGetInterface(UINT32 Device, USBD_DEVICE_INFO* 

DeviceInfo, UINT8 InterfaceNumber) 

{ 

 USB2_INTERFACE Result = {}; 

 USBD_INTERFACE_INFO* Interface = DeviceInfo->pInterfacesInfo + 

InterfaceNumber; 

 if(Interface == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerGetInterface(): The interface was not 

found. Inteface Number = %p\b", 

   InterfaceNumber, 0, 0, 0, 0, 0); 

  return Result; 

 } 

 USBHST_STATUS Status = usbHstSetInterface(Device, Interface-

>uInterfaceNum, Interface->uAlternateSetting); 

 if(Status != USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerGetInterface(): Could not set the 

interface to the host. Status = %p\n", 

   Status, 0, 0, 0, 0, 0); 

  return Result; 
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 } 

 USBHST_INTERFACE_DESCRIPTOR* InterfaceDescriptor = 

usb2FindInterface((pUSBD_DEVICE_INFO)DeviceInfo, Interface->uInterfaceNum, 

  Interface->uAlternateSetting); 

 if(InterfaceDescriptor == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerGetInterface(): Failed to find the 

interface descriptor. " 

   "Interface Number=%p, Alternate Settings=%p\n", Interface-

>uInterfaceNum, 

   Interface->uAlternateSetting, 0, 0, 0, 0); 

  return Result; 

 } 

 USBHST_ENDPOINT_DESCRIPTOR* EndpointDescriptor = 

usb2FindEndpoint((UCHAR*)InterfaceDescriptor, 

  USB2_ATTR_INTERRUPT, USB2_ENDPOINT_IN, 0, 0, 0); 

 if(EndpointDescriptor == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerGetInterface(): Failed to find the 

endpoint descriptor.\n", 

   0, 0, 0, 0, 0, 0); 

  return Result; 

 } 

 USB_TEMPER_INFO("usb2TEMPerGetInterface(): Endpoint Length = 0x%x, 

Endpoint Type = 0x%x, Endpoint Address = 0x%x, " 

  "Endpoint Attributes = 0x%x, Endpoint Max Packet Size = 0x%x, 

Endpoint Interval = 0x%x\n", 

  EndpointDescriptor->bLength, EndpointDescriptor->bDescriptorType, 

EndpointDescriptor->bEndpointAddress, 

  EndpointDescriptor->bmAttributes, EndpointDescriptor-

>wMaxPacketSize, EndpointDescriptor->bInterval); 

 

 Result.EndpointAddress = EndpointDescriptor->bEndpointAddress; 

 Result.Info = Interface; 

 USB_TEMPER_INFO("usb2TEMPerGetInterface(): SUCCEEDED!\n", 0, 0, 0, 0, 

0, 0); 

 return Result; 

} 

 

LOCAL USB2_CONFIGURATION usb2TEMPerSetDefaultConfiguration(UINT32 

DeviceHandle, USBHST_CONFIG_DESCRIPTOR* Configuration) 

{ 

 USB2_CONFIGURATION Result = {}; 

 if(Configuration == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerSetDefaultConfiguration(): Failed to 

get the current configuration in the device.\n", 

   0, 0, 0, 0, 0, 0); 

  return Result; 

 } 

 Result.Index = Configuration->bConfigurationValue-1; 

 if(usbHstSetConfiguration(DeviceHandle, Result.Index) != 

USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerSetDefaultConfiguration(): Failed to 

set the current configuration to the host.\n", 

   0, 0, 0, 0, 0, 0); 
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  Result.Index = 0; 

  return Result; 

 } 

 Result.Initialized = TRUE; 

 USB_TEMPER_INFO("usb2TEMPerSetDefaultConfiguration(): SUCCEEDED!\n", 0, 

0, 0, 0, 0, 0); 

 return Result; 

} 

 

LOCAL void usb2TEMPerSetEndpointAddress(USB2_TEMPER_DEVICE* Device, UINT8 

EndpointIndex, UINT8 EndpointAddress) 

{ 

 Device->EndpointAddresses[EndpointIndex] = EndpointAddress; 

} 

 

LOCAL BOOL usb2TEMPerSetHIDSettings(USB2_TEMPER_DEVICE* Device) 

{ 

 USBHST_STATUS HostStatus = usb2HidProtoSet(Device->ClassDevice, 

USB2_HID_PROTO_REPORT, 

  Device->DeviceTimeout); 

 if(HostStatus != USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerSetHIDSettings(): Could not set boot 

protocol.\n", 

   0, 0, 0, 0, 0, 0); 

  return FALSE; 

 } 

 HostStatus = usb2HidIdleTimeSet(Device->ClassDevice, 

USB2_HID_IDLE_INFINITE, Device->DeviceTimeout); 

 if(HostStatus != USBHST_SUCCESS) 

 { 

  USB_TEMPER_WARN("usb2TEMPerSetHIDSettings(): Could not se idle 

time, still continue.\n", 

   0, 0, 0, 0, 0, 0); 

 } 

 USB_TEMPER_INFO("usb2TEMPerSetHIDSettings(): SUCCEEDED!\n", 0, 0, 0, 0, 

0, 0); 

 return TRUE; 

} 

 

LOCAL BOOL usb2TEMPerAddDeviceToIO(USB2_TEMPER_DEVICE* Device) 

{ 

 if(Device->DeviceHeader != NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerAddDeviceToIO(): DeviceHeader is 

already allocate, please remove from the library first.\n", 

   0, 0, 0, 0, 0, 0); 

  return FALSE; 

 } 

 Device->DeviceHeader = (DEV_HDR*)OSS_CALLOC(sizeof(DEV_HDR)); 

 if(Device->DeviceHeader == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerAddDeviceToIO(): Failed to allocate the 

device header.\n", 

   0, 0, 0, 0, 0, 0); 

  return FALSE; 

 } 
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 STATUS Status = iosDevAdd(Device->DeviceHeader, USB_TEMPER_DEVICE_NAME, 

  Device->DriverNumber); 

 if(Status != OK) 

 { 

  USB_TEMPER_ERR("usb2TEMPerAddDeviceToIO(): Failed to add the 

device to the IO lib.\n", 

   0, 0, 0, 0, 0, 0); 

  OSS_FREE(Device->DeviceHeader); 

  Device->DeviceHeader = NULL; 

  return FALSE; 

 } 

 USB_TEMPER_INFO("usb2TEMPerAddDeviceToIO(): SUCCEEDED!\n", 0, 0, 0, 0, 

0, 0); 

 return TRUE; 

} 

 

LOCAL void usb2TEMPerRemoveDeviceFromIO(USB2_TEMPER_DEVICE* Device) 

{ 

 if(Device->DeviceHeader != NULL) 

 { 

  iosDevDelete(Device->DeviceHeader); 

  OSS_FREE(Device->DeviceHeader); 

  Device->DeviceHeader = NULL; 

 } 

 else 

 { 

  USB_TEMPER_WARN("usb2TEMPerRemoveDeviceFromIO(): Cannot remove 

device from IO lib if device is not already in IO lib.\n", 

   0, 0, 0, 0, 0, 0); 

 } 

} 

 

STATUS usb2TEMPerInit(void) 

{ 

 USB2_TEMPER_DEVICE* Device = usb2TEMPerGetDevice(); 

 if(Device == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerInit(): Device is null, returning.\n", 

0, 0, 0, 0, 0, 0); 

  return ERROR; 

 } 

 if(Device->ClassDevice != NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerInit(): Driver is already initialized, 

returning.\n", 0, 0, 0, 0, 0, 0); 

  return OK; 

 } 

 Device->ClassDriver = usb2ClassDriverCreate(USB_TEMPER_DRIVER_NAME); 

 if(Device->ClassDriver == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerInit(): Failed to create driver.\n", 0, 

0, 0, 0, 0, 0); 

  return ERROR; 

 } 

 Device->ClassDriver->hstDriver.bFlagVendorSpecific = FALSE; 

 Device->ClassDriver->hstDriver.uVendorIDorClass = USB2_HID_CLASS; 

 Device->ClassDriver->hstDriver.uProductIDorSubClass = 0x01; 
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 Device->ClassDriver->hstDriver.uBCDUSBorProtocol = USBD_NOTIFY_ALL; 

 Device->ClassDriver->hstDriver.addDevice = usb2TEMPerDeviceAdd; 

 Device->ClassDriver->hstDriver.removeDevice = usb2TEMPerDeviceRemove; 

 Device->ClassDriver->hstDriver.suspendDevice = usb2TEMPerSuspendResume; 

 Device->ClassDriver->hstDriver.resumeDevice = usb2TEMPerSuspendResume; 

 USBHST_STATUS HostStatus = usbHstDriverRegister(&Device->ClassDriver-

>hstDriver, 

  NULL, "usbGen2TEMPer"); 

 if(HostStatus != USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerInit(): Failed to register with 

USBD...\n", 

   0, 0, 0, 0, 0, 0); 

  usb2ClassDriverDelete(Device->ClassDriver); 

  Device->ClassDriver = NULL; 

  return ERROR; 

 } 

 Device->DriverNumber = iosDrvInstall((FUNCPTR)NULL,  

 (FUNCPTR)NULL,  

 (FUNCPTR)usb2TEMPerOpen, 

 (FUNCPTR)usb2TEMPerClose, 

 (FUNCPTR)usb2TEMPerRead, 

 (FUNCPTR)NULL,  

 (FUNCPTR)NULL); 

 if(Device->DriverNumber == 0) 

 { 

  USB_TEMPER_ERR("usb2TEMPerInit(): IO Driver not installed.\n", 0, 

0, 0, 0, 0, 0); 

  usb2ClassDriverDelete(Device->ClassDriver); 

  Device->ClassDriver = NULL; 

  return ERROR; 

 } 

 USB_TEMPER_INFO("usb2TEMPerInit(): SUCCEEDED!\n", 0, 0, 0, 0, 0, 0); 

 return OK; 

} 

 

STATUS usb2TEMPerShutdown(void) 

{ 

 LOG_MESSAGE("usb2TEMPerShutdown(): Shutting down the TEMPer driver.\n", 

0, 0, 0, 0, 0, 0); 

 return OK; 

} 

 

USBHST_STATUS usb2TEMPerDeviceAdd(UINT32 DeviceHandle, UINT8 InterfaceNumber, 

UINT8 Speed, void** Data) 

{ 

 USBD_DEVICE_INFO *DeviceInfo = NULL; 

 usbdTranslateDeviceHandle(DeviceHandle, (pUSBD_DEVICE_INFO*) 

DeviceInfo); 

 if(DeviceInfo == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to connect to the 

device. DeviceInfo is null.\n", 

   0, 0, 0, 0, 0, 0); 

  return USBHST_FAILURE; 

 } 
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 if((DeviceInfo->uVendorID == USB_TEMPER_VENDOR_ID) && (DeviceInfo-

>uDeviceID == USB_TEMPER_PRODUCT_ID)  

  && (DeviceInfo->uBCDUSB == USB_TEMPER_BCD_ID)) 

 { 

  USB2_TEMPER_DEVICE* Device = usb2TEMPerGetDevice(); 

  USB2_CONFIGURATION Configuration = 

usb2TEMPerSetDefaultConfiguration(DeviceHandle, 

(USBHST_CONFIG_DESCRIPTOR*)DeviceInfo->pCurrentConfiguration); 

  if(Configuration.Initialized == FALSE) 

  { 

   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to the 

default configuration set check, SetDefaultConfiguration.\n", 

    0, 0, 0, 0, 0, 0); 

   return USBHST_FAILURE; 

  } 

  USB2_INTERFACE Interface = usb2TEMPerGetInterface(DeviceHandle, 

DeviceInfo, InterfaceNumber); 

  if((Interface.Info == NULL) || (Interface.EndpointAddress == 0)) 

  { 

   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to get the 

interface, look at the GetInterface() message.\n", 

    0, 0, 0, 0, 0, 0); 

   return USBHST_FAILURE; 

  } 

  STATUS Status = usb2TakeDriver(Device->ClassDriver); 

  if(Status != OK) 

  { 

   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Class driver mutex 

ownership not taken.\n", 

    0, 0, 0, 0, 0, 0); 

   return USBHST_FAILURE; 

  } 

  Device->ClassDevice = usb2ClassDeviceCreate(Device->ClassDriver, 

DeviceHandle, Configuration.Index, 

   Interface.Info->uInterfaceNum, Interface.Info-

>uAlternateSetting); 

  if(Device->ClassDevice == NULL) 

  { 

   usb2ReleaseDriver(Device->ClassDriver); 

   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to create the 

class device.\n", 

    0, 0, 0, 0, 0, 0); 

   return USBHST_FAILURE; 

  } 

  usb2TEMPerSetEndpointAddress(Device, Interface.Info-

>uInterfaceNum, Interface.EndpointAddress); 

  usb2ReleaseDriver(Device->ClassDriver); 

  if(usb2TEMPerSetHIDSettings(Device) == FALSE) 

  { 

   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to set the 

TEMPer device HID settings.\n", 

    0, 0, 0, 0, 0, 0); 

   usb2ClassDeviceDelete(Device->ClassDevice); 

   return USBHST_FAILURE; 

  } 

  if(!usb2TEMPerAddDeviceToIO(Device)) 

  { 
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   USB_TEMPER_ERR("usb2TEMPerDeviceAdd(): Failed to add the 

device to the IO lib. Check AddDeviceToIO message.\n", 

    0, 0, 0, 0, 0, 0); 

   return USBHST_FAILURE; 

  } 

  *Data = Device; 

  USB_TEMPER_INFO("usb2TEMPerDeviceAdd(): Device added!\n", 0, 0, 

0, 0, 0, 0); 

 } 

 return USBHST_SUCCESS; 

} 

 

LOCAL STATUS usb2TEMPerDeleteCallback(USB2_TEMPER_DEVICE* Device) 

{ 

 if(Device->AreWeTransfering == TRUE) return ERROR; 

 if(semTake(Device->ReadMutex, 0) == OK)   

 { 

  semGive(Device->TransferSemaphore); 

  return ERROR; 

 } 

 return OK; 

} 

 

void usb2TEMPerDeviceRemove(UINT32 DeviceHandle, void* Data) 

{ 

 USB2_TEMPER_DEVICE* Device = (USB2_TEMPER_DEVICE*)Data; 

 STATUS Status = usb2TakeDriver(Device->ClassDriver); 

 if(Status != OK) 

 { 

  USB_TEMPER_ERR("usb2TEMPerDeviceRemove(): Could not take driver 

mutex.\n", 

   0, 0, 0, 0, 0, 0); 

  return; 

 } 

 Status = usb2TakeDevice(Device->ClassDevice); 

 if(Status != OK) 

 { 

  USB_TEMPER_ERR("usb2TEMPerDeviceRemove(): Could not take device 

mutex.\n", 

   0, 0, 0, 0, 0, 0); 

  usb2ReleaseDriver(Device->ClassDriver); 

  return; 

 } 

 if(Device->IsWakeupListInitialized) 

 { 

  selWakeupListTerm(Device->WakeupList); 

  Device->IsWakeupListInitialized = FALSE; 

 } 

 usb2TEMPerRemoveDeviceFromIO(Device); 

 usb2DeviceDeleteMsgPost(Device->ClassDevice, usb2TEMPerDeleteCallback, 

Device); 

 usb2ReleaseDevice(Device->ClassDevice); 

 usb2ReleaseDriver(Device->ClassDriver); 

 USB_TEMPER_INFO("USB TEMPer sensor removed!\n", 0, 0, 0, 0, 0, 0); 

} 

 

LOCAL USBHST_STATUS usb2TEMPerURBCompleteCallback(USBHST_URB* URB) 
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{ 

 USB2_TEMPER_DEVICE* Device = usb2TEMPerGetDevice(); 

 Device->AreWeTransfering = FALSE; 

 if(usb2TakeDevice(Device->ClassDevice) == ERROR) 

 { 

  USB_TEMPER_ERR("usb2TEMPerURBCompleteCallback(): Failed to take 

the device mutex.\n", 

   0, 0, 0, 0, 0, 0); 

  return USBHST_FAILURE; 

 } 

 if(URB->nStatus == USBHST_SUCCESS) 

 { 

  rngBufPut(Device->RingBuffer, (char*)Device->Report, 

sizeof(USB2_TEMPER_REPORT)); 

  semGive(Device->TransferSemaphore); 

 } 

 if(Device->Reader == NULL) 

 { 

  usb2ReleaseDevice(Device->ClassDevice); 

  return USBHST_SUCCESS; 

 } 

 USBHST_FILL_INTERRUPT_URB(Device->ClassDevice->pClassSpecificUrb, 

Device->ClassDevice->hDevice, Device->EndpointAddresses[0], 

  (UCHAR*)Device->Report, sizeof(USB2_TEMPER_REPORT), 

USBHST_SHORT_TRANSFER_OK, usb2TEMPerURBCompleteCallback, (void*)Device, 

USBHST_SUCCESS); 

 USB_TEMPER_INFO("hDevice = %p, Address0 = 0x%x, ReportSize = %d\n", 

Device->ClassDevice->hDevice, 

  Device->EndpointAddresses[0], sizeof(USB2_TEMPER_REPORT), 0, 0, 

0); 

 Device->AreWeTransfering = TRUE; 

  

 USBHST_STATUS Status = usbHstURBSubmit(Device->ClassDevice-

>pClassSpecificUrb); 

  

 if(Status != USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerOpen(): usbHstURBSubmit failed! 

Status=%d\n", 

   Status, 0, 0, 0, 0, 0); 

  Device->AreWeTransfering = FALSE; 

  Device->Reader = NULL; 

  usb2ReleaseDevice(Device->ClassDevice); 

  return ERROR; 

 } 

 usb2ReleaseDevice(Device->ClassDevice); 

 return USBHST_SUCCESS; 

} 

 

int usb2TEMPerOpen(void* Pointer, const char* FileName, int Flags, int Mode) 

{ 

 USB_TEMPER_INFO("usb2TEMPerOpen(): Opening the TEMPer device : " 

  "Mode = %p, Flags = %p\n", Mode, Flags, 0, 0, 0, 0); 

 USB2_TEMPER_DEVICE* Device = usb2TEMPerGetDevice(); 

 if(usb2TakeDevice(Device->ClassDevice) != OK) 

 { 
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  USB_TEMPER_ERR("usb2TEMPerOpen(): Cannot take ownership of the 

device mutex.\n", 

   0, 0, 0, 0, 0, 0); 

  errnoSet(EINVAL); 

  return ERROR; 

 } 

 if((Flags & O_RDWR) || (Flags & O_WRONLY) || (Flags && O_CREAT)) 

 { 

  USB_TEMPER_ERR("usb2TEMPerOpen(): Device is not 

writable/creatable.\n", 

   0, 0, 0, 0, 0, 0); 

  errnoSet(EINVAL); 

  usb2ReleaseDevice(Device->ClassDevice); 

  return ERROR; 

 } 

 if(Device->Reader != NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerOpen(): Driver only allows one reader, 

another " 

   "file descriptor is already open, returning an error.\n", 

0, 0, 0, 0, 0, 0); 

  errnoSet(EINVAL); 

  usb2ReleaseDevice(Device->ClassDevice); 

  return ERROR; 

 } 

 USB2_FILE_DESC* FileDescriptor = 

(USB2_FILE_DESC*)OSS_CALLOC(sizeof(USB2_FILE_DESC)); 

 if(FileDescriptor == NULL) 

 { 

  USB_TEMPER_ERR("usb2TEMPerOpen(): Cannot allocate the file 

descriptor data.\n", 0, 0, 0, 0, 0, 0); 

  errnoSet(ENOMEM); 

  usb2ReleaseDevice(Device->ClassDevice); 

  return ERROR; 

 } 

 FileDescriptor->pDevice = Device; 

 FileDescriptor->fdType = Flags; 

 Device->Reader = FileDescriptor; 

 rngFlush(Device->RingBuffer); 

 USBHST_FILL_INTERRUPT_URB(Device->ClassDevice->pClassSpecificUrb, 

Device->ClassDevice->hDevice,  

  Device->EndpointAddresses[0], (UCHAR*)Device->Report, 

sizeof(USB2_TEMPER_REPORT), USBHST_SHORT_TRANSFER_OK, 

usb2TEMPerURBCompleteCallback, (void*)Device, USBHST_SUCCESS); 

 USB_TEMPER_INFO("hDevice = %p, Address0 = 0x%x, ReportSize = %d\n", 

Device->ClassDevice->hDevice, 

  Device->EndpointAddresses[0], sizeof(USB2_TEMPER_REPORT), 0, 0, 

0); 

 Device->AreWeTransfering = TRUE; 

  

  

 USBHST_STATUS Status = usbHstURBSubmit(Device->ClassDevice-

>pClassSpecificUrb); 

 if(Status != USBHST_SUCCESS) 

 { 

  USB_TEMPER_ERR("usb2TEMPerOpen(): usbHstURBSubmit failed! 

Status=%d\n", 
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   Status, 0, 0, 0, 0, 0); 

  errnoSet(EIO); 

  Device->AreWeTransfering = FALSE; 

  Device->Reader = NULL; 

  OSS_FREE(FileDescriptor); 

  usb2ReleaseDevice(Device->ClassDevice); 

  return ERROR; 

 } 

 return (int)FileDescriptor; 

} 

 

int usb2TEMPerClose(USB2_FILE_DESC* FileDescriptor) 

{ 

 USB2_TEMPER_DEVICE* Device = FileDescriptor->pDevice; 

 USB_TEMPER_INFO("usb2TEMPerClose(): Closing the temperature sensor 

%s\n", 

  Device->DeviceHeader->name, 0, 0, 0, 0, 0); 

 if(usb2TakeDevice(Device->ClassDevice) != OK) 

 { 

  USB_TEMPER_ERR("usb2TEMPerClose() Cannot take ownership of the 

device mutex.\n", 

   0, 0, 0, 0, 0, 0); 

  return ERROR; 

 } 

 if(Device->Reader == FileDescriptor) 

 { 

  USB_TEMPER_ERR("usb2TEMPerClose(): Reset device reader to 

NULL.\n", 

   0, 0, 0, 0, 0, 0); 

  Device->Reader = NULL; 

 } 

 OSS_FREE(FileDescriptor); 

 usb2ReleaseDevice(Device->ClassDevice); 

 return OK; 

} 

 

ssize_t usb2TEMPerRead(void* FileDescriptor, char* Buffer, size_t MaxBytes) 

{ 

 USB2_TEMPER_DEVICE* Device = usb2TEMPerGetDevice(); 

 if(usb2TakeDevice(Device->ClassDevice) != OK) 

 { 

  errnoSet(EIO); 

  return ERROR; 

 } 

 size_t RingBufferSize = rngNBytes(Device->RingBuffer); 

 if(RingBufferSize == 0) 

 { 

  if(semTake(Device->ReadMutex, WAIT_FOREVER) != OK) 

  { 

   errnoSet(EIO); 

   usb2ReleaseDevice(Device->ClassDevice); 

   return ERROR; 

  } 

  usb2ReleaseDevice(Device->ClassDevice); 

  if(semTake(Device->TransferSemaphore, WAIT_FOREVER) != OK) 

  { 

   errnoSet(EIO); 
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   semGive(Device->ReadMutex); 

   return ERROR; 

  } 

  semGive(Device->ReadMutex); 

  if(usb2TakeDevice(Device->ClassDevice) != OK) 

  { 

   errnoSet(EIO); 

   return ERROR; 

  } 

 } 

 size_t Result = rngBufGet(Device->RingBuffer, Buffer, MaxBytes); 

 usb2ReleaseDevice(Device->ClassDevice); 

 return Result; 

} 

 

void usb2TEMPerSuspendResume(UINT32 Device, void* Data) 

{ 

 USB_TEMPER_WARN("usb2TEMPerSuspendResume(): This function is not 

supported.\n", 

  0, 0, 0, 0, 0, 0); 

}*/ 

 

static void temper_html(char *params, int length) 

{ 

 httpd_header(HTTP_OK, CONTENT_TEXT_HTML); 

 printf("<!DOCTYPE html><html lang=\"en\"><head><meta charset=\"utf-

8\"><title>VxWorks Temperature Sensor</title><style>body {text-align: 

center;}data {float: left;width: 200px;height: 100px;margin: 200px;border: 

1px solid rgba(0,0,0,.2);background: rgb(0,45,114);}button {background-color: 

rgb(0,45,114);border: none;color: white;padding: 15px 32px;text-align: 

center;text-decoration: none;display: inline-block;font-size: 16px;margin: 

4px 2px;cursor: pointer;}</style></head><body><h1>VxWorks Temperature 

Sensor</h1><p>Click the button below to read data from the temperature sensor 

attached to VxWorks:</p><button class = \"button\" onclick = 

\"loadData('temperaturedata.xml',updateData)\">Request temperature 

data</button><br><br><div id=\"data\"></div><script>function 

updateData(xhttp){var xmlDoc, text, celsius, fahrenheit;xmlDoc = 

xhttp.responseXML;var date = new Date();if(!date) 

{document.getElementById(\"data\").innerHTML = \"Date retrieval 

failed\";console.log(\"Date retrieval failed\");return;}var months = 

[\"January\", \"February\", \"March\", \"April\", \"May\", \"June\", 

\"July\", \"August\", \"September\", \"October\", \"November\", 

\"December\"];var days = [\"Sunday\", \"Monday\", \"Tuesday\", \"Wednesday\", 

\"Thursday\", \"Friday\", \"Saturday\"];text = \"The temperature in celsius 

and fahrenheit in the FGCU Holmes Engineering lab, room 429 on \";text += 

days[date.getDay()] + \", \";text += months[date.getMonth()] + \" \";text += 

date.getDate() + \", \";text += date.getFullYear() + \" at \";var currHour = 

date.getHours();if(currHour > 12){currHour -= 12;text += currHour + \":\";var 

currMinute = date.getMinutes();if(currMinute < 10) text += \"0\";text += 

currMinute + \":\";var currSecond = date.getSeconds();if(currSecond < 10) 

text += \"0\";text += currSecond + \" PM\";}else{text += currHour + \":\";var 

currMinute = date.getMinutes();if(currMinute < 10) text += \"0\";text += 

currMinute + \":\";var currSecond = date.getSeconds();if(currSecond < 10) 

text += \"0\";text += currSecond + \" AM\";}text += \" is:<br><br>\";celsius 

= xmlDoc.getElementsByTagName(\"CELSIUS\");text += \"Celsius: \";text += 

celsius[0].childNodes[0].nodeValue + \" °C<br>\";fahrenheit = 

xmlDoc.getElementsByTagName(\"FAHRENHEIT\");text += \"Fahrenheit: \";text += 
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fahrenheit[0].childNodes[0].nodeValue + \" 

°F<br>\";document.getElementById(\"data\").innerHTML = 

text;console.log(text);}function loadData(url, callback){var 

xhttp;if(window.XMLHttpRequest){xhttp = new 

XMLHttpRequest();if(!xhttp){console.log(\"XMLHTTPRequest 

failed\");document.getElementById(\"data\").innerHTML = \"XMLHttpRequest 

failed.\";return;}else{console.log(\"XMLHTTPRequest good\");}}else{xhttp = 

new 

ActiveXObject(\"Microsoft.XMLHTTP\");if(!xhttp){console.log(\"ActiveXObject 

creation failed.\");return;}else{console.log(\"ActiveXObject 

good\");}}xhttp.onreadystatechange = function() {if(this.readyState == 

4){callback(this);console.log(\"good\");}else{console.log(\"readyState: \" + 

this.readyState);console.log(\"status: \" + 

this.status);}};xhttp.open(\"GET\", url, 

true);xhttp.send();}</script></body></html>"); 

} 

float celsius, fahrenheit; 

void temper() 

{ 

 /*get degrees in celsius from the TEMPer sensor and then convert to 

fahrenheit*/ 

 /*celsius = usb2TEMPerRead();*/ 

 celsius = 26.4f; 

 fahrenheit = (celsius * 1.8f) + 32.0f; 

} 

static void temper_xml(char *params, int length) 

{ 

 /*get temperature data from USB*/ 

 temper(); 

 char buffer[256]; 

 sprintf(buffer,"<TEMP>\n\t<CELSIUS>%.1f</CELSIUS>\n\t<FAHRENHEIT>%.1f</

FAHRENHEIT>\n</TEMP>",celsius,fahrenheit); 

 httpd_keep_alive(HTTPD_OK, CONTENT_TEXT_XML, strlen(buffer), buffer); 

} 

int main() 

{ 

 if(HTTPD_OK != httpd_start(80)) 

 { 

  logMsg("Cannot start the server",0,0,0,0,0,0); 

  return -1; 

 } 

 httpd_register_resource("/temperature.html", &temper_html); 

 httpd_register_resource("/temperaturedata.xml",&temper_xml); 

 return 0; 

} 


